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:درسسرفصل

(غیرهوکشینقشهدرپرکاربردهایاستانداردترسیم،ابزارهای)مقدماتیمفاهیم✓
نماسهرسموتصویرتئوری✓
(آندیگرنمایدوداشتنباصفحهیکوخطیکنقطه،یکسومتصویررسم)یابینقطه✓
(یابیمجهولوتجسمبرایکمکیروش)سطوحتحلیلوتجزیه✓
(آندیگرنمایدوداشتنباسومنمایکردنپیدا)یابیمجهول✓
ایزومتریکمجسمتصاویررسمروشوبعدیسهتصاویرمعرفی✓
(غیرهومرکببرشمتوالی،برشساده،برشزدن،برشاصول)برش✓
اتوکدباگذاریاندازه،(نویسیاندازهقواعدمتریک،واحدهایآن،اصطلاحات)نویسیاندازه✓
AutoCADمحیطدردوبعدیتصاویررسم✓

AutoCADمحیطدربعدیسهتصاویررسم✓
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ISIRI 
(1960)

Institute of 
Standards and 
Industrial 
Research of Iran

BSI 
(1902)

CSA
Canadian 
standard 

Association

DIN 
(1917)

Deutsches Institut 
für Normung

ISA 
(1926)

ISO - International Standard Organization (1947)

سوندی ، دکتر شاه1کشی صنعتینقشه

https://www.iso.org/home.html


7

سوندی ، دکتر شاه1کشی صنعتینقشه



8

سوندی ، دکتر شاه1کشی صنعتینقشه



9

سوندی ، دکتر شاه1کشی صنعتینقشه



10

کشی متداول استدر نقشه
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Technical drawing pen size: 

https://www.designingbuildings.co.uk/wiki/Paper_Sizes

Note: m ISO = metric ISO
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های مکانیکیخطوط در نقشه

سوندی ، دکتر شاه1کشی صنعتینقشه



14
https://www.easynotecards.com/notecard_set/49991

1 2 3, 7

https://engineeringdrawingbasics.com/different-line-types-used-on-engineering-drawings/

https://www.google.com/url?sa=i&url=https%3A%2F%2Fwww.koraputiti.in%2Fcategory%2Fclass-

notice%2Fnotes%2Fengineering-drawing%2F&psig=AOvVaw0DYmIKU0WGczzTryn-

ti1E&ust=1665496966544000&source=images&cd=vfe&ved=0CA0QjhxqFwoTCODsxerp1foCFQA

AAAAdAAAAABAh
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Engineering Drawing and Design – Page: 183
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https://www.artstation.com/artwork/8wmrwO
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https://www.vvsd.org/cms/lib/IL01905528/Centricity/Domain/3480/ALPHABET%20OF%20LINES.pptx
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گونیای ثابت گونیای متغیر

گونیا
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رسم کرد چیست؟45و 60-30توان با گونیای ای که میحداقل زاویه
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خط کش تی
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تخته رسم کشیمیز نقشه

کشی و تخته رسممیز نقشه
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اشل

https://sazeplus.com/product/scale-dwg/
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Engineering drawing and design
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پرگار

هابرای انتقال اندازه: گیرپرگار اندازه
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شمنحنی ک-شابلون پیستوله

ماری کش

شابلون

شابلون معماری

کنشابلون پاک
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نقاله
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برس
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چسب

چسب کاغذیچسب کالک

یچسب پلاستیک
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درفتینگ
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کاغذ

کاغذ کالک کاغذ پوستی کاغذ سفید
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کاغذ

(های اسکچبرای نقشه)کاغذ شطرنجی  کاغذ میلیمتری

کاغذ ایزومتریک

کاغذ لگاریتمی
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Dr. Walter Porstmann (1886-1959)

The ISO 216 standard defines the "A" and "B" series of paper sizes.

The ISO 269 "C" series is commonly listed alongside the A and B sizes.

The area of B size sheets are the geometric mean of successive A-series 

sheets. For instance, the area of the B1 sheet (0.707 m²) is in between A0 (1 

m²) and A1 (0.5 m²). The B Series is used for passports, envelopes and 

posters. B5 has become a conventional size for many books.

The entire C-series suite of envelopes are designed to hold their A-series’ 

counterparts, and are defined by ISO 269. The area of C series sheets is 

the geometric mean of the areas of the A and B series sheets of the same 

number. So, the area of a C4 sheet is the geometric mean of the areas of an 

A4 sheet and a B4 sheet.

The A-series was derived from a rectangle piece of paper (A0) having 

an area of 1 m2, the length of whose sides are in the proportion 1:√2 (1: 

1.4142).

Paper Size: 

https://www.designingbuildings.co.uk/wiki/Paper_Sizes
The advantages of basing 

a paper size on an aspect ratio 

of √2 was first noted in 1786 

by the German scientist and 

philosopher Georg Christoph 

Lichtenberg.

سوندی ، دکتر شاه1کشی صنعتینقشه

https://www.designingbuildings.co.uk/wiki/Standards
https://www.designingbuildings.co.uk/wiki/Size
https://www.designingbuildings.co.uk/wiki/Area
https://www.designingbuildings.co.uk/wiki/Size
https://www.designingbuildings.co.uk/wiki/Geometric
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https://www.designingbuildings.co.uk/wiki/Envelope
https://www.designingbuildings.co.uk/wiki/Size
https://www.designingbuildings.co.uk/wiki/Envelope
https://www.designingbuildings.co.uk/wiki/Area
https://www.designingbuildings.co.uk/wiki/Geometric
https://www.designingbuildings.co.uk/wiki/Area
https://www.designingbuildings.co.uk/wiki/Area
https://www.designingbuildings.co.uk/wiki/Geometric
https://www.designingbuildings.co.uk/wiki/Area
https://www.designingbuildings.co.uk/wiki/Paper
https://www.designingbuildings.co.uk/wiki/Area
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1189

841
= 2
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https://www.digitalprinting.co.uk/support/paper-weight-

guide/#:~:text=80%20%E2%80%93%20100gsm%3A%20The%20weight%20range,as%20letterheads%20and%20compliment%20slips.
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https://slidetodoc.com/chapter-1-introduction-contents-engineering-drawing-

drawing-standards/
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رسم عمود بر
یک خط
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رسم عمود بر یک خط
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رسم عمود بر یک خط
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رسم دایره 
گذرنده از 
سه نقطه
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رسم دایره گذرنده از 
سه نقطه
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پیدا کردن 
مرکز دایره
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ا رسم مثلت ب
ه استفاده از س
ضلع معلوم
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رسم مثلت با داشتن
سه پاره خط
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رسم نیمساز
زاویه
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D

رسم نیمساز زاویه
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رسم خط 
موازی
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رسم خط موازی
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تقسیم خط 
قسمت nبه 

مساوی
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قسمت مساویnتقسیم خط به 
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رسم 
چندضلعی 

منتظم
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سه ضلعی منتظم
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چهار ضلعی منتظم
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شش ضلعی منتظم
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شش ضلعی منتظم
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هشت ضلعی منتظم
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چند ضلعی منتظم
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ه ترسیم دایر
...مماس بر 
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ترسیم دایره مماس بر دو خط
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ترسیم دایره مماس بر خط و دایره
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ترسیم دایره مماس خارجی بر دو دایره
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ترسیم دایره مماس داخلی بر دو دایره
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(مماس داخلی و خارجی)ترسیم دایره مماس  بر دو دایره 
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انواع فرجه، خط و صفحه

Chapter 8 Chapter 4
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، خط و صفحه(ناحیه)فرجه 

https://rockbench.ir/drawing-03/
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https://raman01.ir/analysis-view-and-volume/
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https://rockbench.ir/drawing-03/

(فرجه سوم)و در استاندارد آمریکایی ( برای فرجه اول)ISO. در نقشه کشی صنعتی فرجه اول و سوم کاربرد دارد
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اگر خطی با صفحات اصلی موازی باشد دارای اندازه
.حقیقی در آن تصویر است

ه خطی که بر صفحه عمود است، تصویرش یک نقط
.خواهد بود

:انواع خط
(عمود بر صفحه افقی)خط قائم -1
(عمود بر صفحه جانبی)خط مواجه -2
(عمود بر صفحه قائم)خط منتصب -3
(موازی صفحه قائم)جبهیه /خط جبهی-4
(موازی صفحه جانبی)خط نیمرخ -5
(موازی صفحه افقی)خط افقیه -6
(نه موازی و نه عمود)خط غیرخاص -7

سوندی ، دکتر شاه1کشی صنعتینقشه
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ه گروه دیگر خط و صفحه هایی هستند که نسبت ب
.صفحات اصلی تصویر زاویه دارند

:انواع خط
(عمود بر صفحه افقی)خط قائم -1
(عمود بر صفحه جانبی)خط مواجه -2
(عمود بر صفحه قائم)خط منتصب -3
(موازی صفحه قائم)جبهیه /خط جبهی-4
(موازی صفحه جانبی)خط نیمرخ -5
(موازی صفحه افقی)خط افقیه -6
(نه موازی و نه عمود)خط غیرخاص -7

سوندی ، دکتر شاه1کشی صنعتینقشه
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د دارای صفحاتی که با صفحه اصلی تصویر موازی باشن
.تصویر حقیقی هستند

:انواع صفحه

جبهیه/ صفحه جبهی-1
صفحه نیمرخ-2
صفحه افقی-3
صفحه منتصب-4
صفحه مواجه-5
صفحه قائم-6
(نه عمود و نه موازی)صفحه غیرخاص -7
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.در احجام صفحات شیب دار هم کاربرد زیادی دارند

:انواع صفحه

جبهیه/ صفحه جبهی-1
صفحه نیمرخ-2
صفحه افقی-3
صفحه منتصب-4
صفحه مواجه-5
صفحه قائم-6
(نه عمود و نه موازی)صفحه غیرخاص -7
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https://raman01.ir/%D9%BE%D9%88%D8%AF%D9%85%D8%A7%D9%86-%D8%B3%D9%88%D9%85-%D8%AA%D8%B1%D8%B3%DB%8C%D9%85-%D8%B3%D9%87-

%E2%80%8C%D9%86%D9%85%D8%A7-%D9%88-%D8%AD%D8%AC%D9%85/
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https://rockbench.ir/drawing-04/
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https://rockbench.ir/drawing-04/
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یابینقطه
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https://raman01.ir/%D9%BE%D9%88%D8%AF%D9%85%D8%A7%D9%86-%D8%B3%D9%88%D9%85-%D8%AA%D8%B1%D8%B3%DB%8C%D9%85-%D8%B3%D9%87-

%E2%80%8C%D9%86%D9%85%D8%A7-%D9%88-%D8%AD%D8%AC%D9%85/
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https://raman01.ir/%D9%BE%D9%88%D8%AF%D9%85%D8%A7%D9%86-%D8%B3%D9%88%D9%85-%D8%AA%D8%B1%D8%B3%DB%8C%D9%85-%D8%B3%D9%87-

%E2%80%8C%D9%86%D9%85%D8%A7-%D9%88-%D8%AD%D8%AC%D9%85/
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https://raman01.ir/%D9%BE%D9%88%D8%AF%D9%85%D8%A7%D9%86-%D8%B3%D9%88%D9%85-%D8%AA%D8%B1%D8%B3%DB%8C%D9%85-%D8%B3%D9%87-

%E2%80%8C%D9%86%D9%85%D8%A7-%D9%88-%D8%AD%D8%AC%D9%85/
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ه گروه دیگر خط و صفحه هایی هستند که نسبت ب
.صفحات اصلی تصویر زاویه دارند

:انواع خط
(عمود بر صفحه افقی)خط قائم -1
(عمود بر صفحه جانبی)خط مواجه -2
(عمود بر صفحه قائم)خط منتصب -3
(موازی صفحه قائم)جبهیه /خط جبهی-4
(موازی صفحه جانبی)خط نیمرخ -5
(موازی صفحه افقی)خط افقیه -6
(نه موازی و نه عمود)خط غیرخاص -7

سوندی ، دکتر شاه1کشی صنعتینقشه



109

سوندی ، دکتر شاه1کشی صنعتینقشه
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سوندی ، دکتر شاه1کشی صنعتینقشه
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https://rockbench.ir/drawing-04/

سوندی ، دکتر شاه1کشی صنعتینقشه
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سوندی ، دکتر شاه1کشی صنعتینقشه
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سوندی ، دکتر شاه1کشی صنعتینقشه
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سوندی ، دکتر شاه1کشی صنعتینقشه
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سوندی ، دکتر شاه1کشی صنعتینقشه
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سوندی ، دکتر شاه1کشی صنعتینقشه



117

سوندی ، دکتر شاه1کشی صنعتینقشه
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سوندی ، دکتر شاه1کشی صنعتینقشه
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φ50

60

φ20

سوندی ، دکتر شاه1کشی صنعتینقشه
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سوندی ، دکتر شاه1کشی صنعتینقشه
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تصاویر مجسم

https://rockbench.ir/drawing-10/

.شوندزاویه محورها به سه دسته تقسیم میتصاویر مجسم بر اساس

سوندی ، دکتر شاه1کشی صنعتینقشه
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Computer-Aided Design

John Walker

developed by the French company Dassault Systèmes

سوندی ، دکتر شاه1کشی صنعتینقشه
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1-1
تاریخچه•

1-2
زارنمایی‌شماتیک‌از‌پنجره‌اصلی‌و‌میله‌ابزارهای‌نرم‌اف•

1-3
عملکرد‌موس‌و‌کیبورد•

1-4
تعاریف‌عمومی•

سوندی ، دکتر شاه1کشی صنعتینقشه
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صفحه ترسیم

اشاره گر موس

محور مختصات 
(UCS Center)

های دستورهاپانل

هازبانه (InfoCenter)مرکز اطلاعات 
نوار ابزار دسترسی سریع 

(Quick Access Toolbar)

خط فرمان 
(Command Line)

روبان 
(Ribbon)

(Title Bar)نوار عنوان 

شتعیین حالت نمای

نوار وضعیت
(Status Bar)

سوندی ، دکتر شاه1کشی صنعتینقشه
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عملکرد موس و کیبورد1-3

.شودمیاستفادهاتوکددرجداولوهاپیغامموضوعات،ها،آیکنانتخاببرایکلیدایناز:موسچپکلیدعملکرد❖

:شویدمیمواجهزیرحالتدوباصفحه،درنگهداشتنوکردنکلیکازپسموضوعات،انتخاببرای

قرارانتخابموردراآنهاموضوعات،بامستطیلبرخوردکوچکترینباکهشودمیظاهرسبزمستطیلچپ،سمتبهموسحرکتصورتدر.۱
.دهدمی
موردراگیرندمیقرارمستطیلایندرونکاملطوربهکهموضوعاتیتنهاکهشودمیظاهرآبیمستطیلدهید،حرکتراستسمتبهراموساگر.2

.دهدمیقرارانتخاب

انتخابحالتازراموضوعاتموس،چپکلیدازاستفادهباوداشتهنگهپایینراShiftکلیدانتخاب،حالتازموضوعاتازبرخیکردنخارجبرای
.کنیدخارج

سوندی ، دکتر شاه1کشی صنعتینقشه
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:(Scroll)موسوسطکلیدعملکردهای❖

میگفته zoomآنبهاصطلاحاًکهکردهتغییرصفحهبزرگنمایی،عقبیاجلوسمتبهکلیدایندادنحرکتبا.۱
.شود
بهاصطلاحاکهشدهجابجاکارییصفحهدهیم،حرکتراموسودادهفشارپایینسمتبهراموسوسطکلیداگر.2
.شودمیگفتهPanآن
عملاینبهاصطلاحاًکهگیردمیقرارکاربردیدکانونییمحدودهدرموضوعاتتمامیکلید،ایندادنفشاردوباربا.3

zoom extendشودمیگفته.
.دادحرکتانیمیشنیصورتبهراصفحهتوانمی،ScrollرویبرکلیکوCtrlکلیدداشتننگهبا.4
.کردمنتقلبعدیسهمحیطبهرانماتوانمی Scrollرویبرکلیکو shiftکلیدداشتننگهبا.5

.گیردمیقراراستفادهموردموضوعاتکردنتکراروتثبیتتایید،برایکلیددوهر:Enter & Space barکلید❖
.گیردمیقراراستفادهموردهاوپیغامجداولدستورات،کردن Cancelبرای: Escکلید❖
.گیردمیقراراستفادهموردشدهبازهایفایلتمامیبینشدنجابجابرای: Ctrl+ Tabکلید❖

.نموداستفادهصفحاتبینشدنجابجابرایتوانمینیزWindowسربرگاز

سوندی ، دکتر شاه1کشی صنعتینقشه
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.استزیرصورتبهآنهاازبرخیعملکردگویندکهتابعکلیدهایرا F12تا F1کلیدهای:تابعکلیدهای✓
۱.F1:کردنبازبرایHelp افزارنرم.
2.F2:بیشترجزئیاتبافرمانخطدادننشانبرای.
3.F4&F3:کردنفعالغیریافعالبرایObject Snap ها.
4.F7:طراحیفضایشطرنجییزمینهپسکردنفعالغیریافعالمنظوربه.
5.F8:کردنفعالغیریافعالبرایOrthoنمودرسمعمودییاافقیصورتبهراخطتوانمیتنهاکلید،اینبودنفعالصورتدر.شودمیاستفاده.
6.F9:رویبرفقطموسنشانگرکلیداینبودنفعالصورتدرgridکندمیحرکت(طراحیفضایدرمشبکخطوط)ها.
7.F10:کردنغیرفعالیافعالبرایکلیداینازpolarشودمیاستفاده.

سوندی ، دکتر شاه1کشی صنعتینقشه
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.استشدهدادهتوضیحزیردرآنهایعملکردازبرخیکهکردهباززیرصورتبهایصفحهمنوییک:موسراستکلیدعملکرد❖

سوندی ، دکتر شاه1کشی صنعتینقشه
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Ctrl+9

In Command Type: MENUBAR

سوندی ، دکتر شاه1کشی صنعتینقشه
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سوندی ، دکتر شاه1کشی صنعتینقشه
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سوندی ، دکتر شاه1کشی صنعتینقشه
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3-1
AutoCADفضاهای‌کاری‌در‌نرم‌افزار‌•

3-2 ی‌جدیدی‌باز‌کردن‌صفحهطریقه•

3-3 ابزاری‌ایجاد‌میلهطریقه•

3-4 زمینهی‌تغییر‌رنگ‌پسطریقه•

3-5 های‌اجرای‌دستوراتروش•

3-6 های‌تکرار‌دستوراتروش•

سوندی ، دکتر شاه1کشی صنعتینقشه
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AutoCADفضاهای کاری در نرم 3-1

:به‌صورت‌زیر‌می‌باشدAutoCADفضاهای‌مختلف‌طراحی‌در‌

روش‌می‌توان‌وارد‌محیط‌نرم‌افزار‌اتوکد‌شد‌4به‌

workspaceطریق‌میله‌ابزار‌از-۱

بالای‌صفحه‌ ribbonاز‌طریق-2
workspacesو‌انتخاب‌ toolsکلیک‌بر‌روی‌منوی-3

 (work space switching)از‌آیکن‌چرخ‌دنده‌در‌پایین‌صفحه-4

سوندی ، دکتر شاه1کشی صنعتینقشه
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ی جدیدی باز کردن صفحهطریقه3-2

.کلیک‌کنید..Newکلیک‌کرده‌و‌سپس‌از‌پنجره‌ی‌ظاهرشده‌بر‌روی‌گزینه‌یFileبرای‌باز‌کردن‌صفحه‌ی‌جدید‌ابتدا‌بر‌روی‌گزینه‌ی‌

یگزینهانتخابباتوانیممیشودمیبازبالاشکلمطابقکهایپنجرهدر
acadاینچواحدباجدیدیصفحهیک(inches)کنیمباز

بایستمیمیلیمترواحدباصفحاتکردنبازبرایکهاستذکربهلازم
.کنیمکلیکacadisoیگزینهرویبر

منویاز(model space)طراحیفضایواحدنوعازآگاهیبرای
formatیگزینهunits…دروشدهظاهریپنجرهدرکرده،انتخابرا
نشانصفحهواحدنوع Units to scale inserted contentقسمت
استشدهداده

سوندی ، دکتر شاه1کشی صنعتینقشه
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ی ایجاد میله ابزارطریقه3-3

:توان‌میله‌ابزارها‌را‌درون‌اتوکد‌ایجاد‌کردبه‌سه‌روش‌زیر‌می

.ها‌کلیک‌راست‌بر‌روی‌آیکن-۱

.ی‌خاکستری‌اتوکدکلیک‌راست‌بر‌روی‌حاشیه-2

.AutoCADوسپس‌انتخاب‌toolbarsی‌و‌انتخاب‌گزینهtoolکلیک‌برروی‌منوی‌-3

 backgroundزمینه یا ی تغییر رنگ پسطریقه3-4

:کنیمبرای‌تغییر‌رنگ‌پس‌زمینه‌مراحل‌زیر‌را‌دنبال‌می

سوندی ، دکتر شاه1کشی صنعتینقشه
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های اجرای دستوراتروش3-5

:توان‌دستورات‌را‌در‌اتوکد‌اجرا‌نمودهای‌زیر‌میبه‌روش

خط‌فرمان-۱

...(و،،‌)‌آیکون‌-2

حرف‌خلاصه-3

کلیدهای‌ترکیبی-4

باتوانندمیکاربرانکهشدهظاهردستوراتخلاصهحرف(Alt)کلیدداشتننگهبا
.کنندظاهرراآنیپنجرهمربوطه،کلیدفشردن

سوندی ، دکتر شاه1کشی صنعتینقشه
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منوی‌بالای‌صفحه-5

های تکرار دستوراتروش3-6

:های‌تکرار‌دستورات‌در‌اتوکد‌به‌صورت‌زیر‌استروش

Enterکلید‌-۱

Spaceکلید‌-2

… Repeatکلیک‌راست‌در‌صفحه‌و‌انتخاب‌-3

recent inputکلیک‌راست‌در‌صفحه‌و‌انتخاب‌گزینه‌-4

با‌استفاده‌از‌کلیدهای‌جهت‌نما-5

سوندی ، دکتر شاه1کشی صنعتینقشه
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2-1
سیستم‌مختصاتی‌کارتزین‌یا‌دکارتی‌•

2-2
سیستم‌مختصاتی‌پلار‌یا‌قطبی‌•

سوندی ، دکتر شاه1کشی صنعتینقشه
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باعثچونگیردمیقراراستفادهموردندرتبهسیستماینروازاینکنند،محاسبه (UCS)مبدابهنسبترانقاطتمامیمختصاتبایستیکاربرانسیستمایندر
(.استدوربینباکاروبردارینقشهدردستوراینبیشترکاربرد).شودمیپروژهپیشرفتکندی

سیستم مختصاتی کارتزین یا دکارتی 2-1

.کندکند‌در‌غیر‌این‌صورت‌نسبت‌به‌مبدا‌مختصات‌رسم‌میی‌قبل‌رسم‌میی‌بعدی‌را‌نسبت‌به‌نقطهنقطهAutoCADقرار‌دهیم،‌@اگر‌قبل‌از‌مختصات‌دهی‌

.قبل‌از‌نقاط‌نداریم@فعال‌باشد،‌نیازی‌به‌نوشتن‌F12در‌صورتی‌که‌کلید‌

سوندی ، دکتر شاه1کشی صنعتینقشه
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.کندحرکت0،90،۱80،270زوایایدرتنهاخطتاکردهفعالراOrthoیگزینهتوانمیسیستمدراین

:نمودعملزیرصورتدوبهتوانمیOrthoگزینهنمودنفعالبرای

F8فشردن‌کلید‌-۱

.‌کلیک‌بر‌روی‌گزینه‌ی‌‌‌‌‌‌در‌نوار‌وضعیت-2

را‌پایین‌نگه‌داشته‌تا‌خط‌تنها‌در‌راستای‌(‌Shift)توان‌عمل‌نمود‌که‌پس‌از‌کلیک‌در‌صفحه‌کلید‌برای‌رسم‌خطوط‌افقی‌یا‌عمودی‌به‌این‌صورت‌نیز‌می

.افقی‌یا‌عمودی‌حرکت‌کند

سوندی ، دکتر شاه1کشی صنعتینقشه



141

سیستم مختصاتی پلار یا قطبی 2-2

مبداونظرموردینقطهواصلخطبینیزاویه)αو(مختصاتمبداازنقطهیفاصله)rپارامتردوبهقطبیمختصاتدستگاهدرنقطهیکنمودنمشخصبرای
.(شکلمطابق)داریمنیاز(هاXمحورمثبتجهتبامختصات

سپسوخططولابتدافرمانخطجلویدرمنظوراینبه
زیرصورتبه(<)علامتیکباراها Xمحورباآنیزاویه
.کنیممیوارد

سوندی ، دکتر شاه1کشی صنعتینقشه
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Line:نام دستور

:زبانه

Draw  ->  Line

:آیکن :حرف خلاصه

L

1-Line 

.کردمهارراخطکارتزینوپلارمانندمختصاتیهایسیستمکمکبهآناجرایازپستوانمیکهشودمیاستفادهخطوطترسیمبرایدستورایناز

سوندی ، دکتر شاه1کشی صنعتینقشه
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2-Erase

Erase:نام دستور

:زبانه

Modify  ->  Erase

:آیکن :حرف خلاصه

E

.شوداز‌این‌دستوربرای‌پاک‌کردن‌موضوعات‌استفاده‌می

سوندی ، دکتر شاه1کشی صنعتینقشه
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کنیمهای‌ارائه‌شده‌در‌زیر‌عمل‌میبه‌منظور‌انتخاب‌و‌حذف‌موضوعات‌به‌یکی‌از‌روش

شود‌که‌با‌کوچکترین‌برخورد‌این‌پنجره‌با‌موضوعات‌،آنها‌را‌مورد‌انتخاب‌قرار‌پس‌از‌کلیک‌در‌صفحه‌موس‌را‌به‌سمت‌چپ‌حرکت‌دهید‌مستطیل‌سبز‌ظاهر‌میاگر‌-۱
.دهدگیرد‌مورد‌انتخاب‌قرار‌میشود‌که‌تنها‌موضوعاتی‌را‌که‌کاملاً‌درون‌آن‌قرار‌میدر‌صورت‌حرکت‌موس‌به‌سمت‌راست‌مستطیل‌آبی‌ظاهر‌می.‌دهدمی

2-All ی‌موضوعات‌یا‌همه
Eraseاجرای دستور 

در خط فرمانAllتایپ 

Enterزدن دو بار کلید 

تمامی موضوعات پاک می شود

3-Last یا‌آخرین‌موضوع

Eraseاجرای دستور 

در خط فرمانLastتایپ 

Enterزدن دو بار کلید 

آخرین موضوع پاک می شود

را‌فشار‌داده‌تا‌موضوعات‌انتخابی‌Deleteتوان‌پس‌از‌انتخاب‌آنها‌کلید‌برای‌پاک‌کردن‌موضوعات‌می
.پاک‌شوند

سوندی ، دکتر شاه1کشی صنعتینقشه
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های‌بازگرداندن‌موضوعاتروش
Erase

E: حرف خلاصه •

پاک کردن موضوعات:عملکرد•

Undo

U:حرف خلاصه•

Ctrl+z:کلید ترکیبی •

eraseبازگرداندن موضوعات پاک شده توسط : عملکرد•

Redo

---:حرف خلاصه•

Ctrl+y:کلید ترکیبی •

بازگرداندن آخرین موضوع پاک شده:عملکرد •

توانند‌به‌شود‌که‌کاربران‌میای‌به‌صورت‌زیر‌ظاهر‌میپنجرهMredoپس‌از‌اجرای‌دستور‌
.یکی‌از‌دو‌صورت‌زیر‌برای‌بازگرداندن‌اطلاعات‌عمل‌نمایند

سوندی ، دکتر شاه1کشی صنعتینقشه
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سوندی ، دکتر شاه1کشی صنعتینقشه
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سوندی ، دکتر شاه1کشی صنعتینقشه
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3-Polyline

Polyline:نام دستور

:زبانه

Draw -> Polyline

:آیکن :حرف خلاصه

Pl

.این‌دستور‌بعد‌از‌اجرا‌دارای‌پارامترهایی‌به‌شرح‌زیر‌است.‌شودبرای‌ترسیم‌خطوط‌متصل‌به‌هم‌استفاده‌می

۱-arc:حرفازخطبهکمانبازگشتبرایوکردهکمانبهتبدیلراخطLمخففکهLineکنیممیاستفادهاست.
2-Length :خططولکردنواردبرایPolylineشودمیاستفاده.
3-Width & half Width :کهتفاوتاینباکندمیعریضراخطپارامتر،دوهرhalf widthبرابردوعرضی Widthکندمیایجاد
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سوندی ، دکتر شاه1کشی صنعتینقشه
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سوندی ، دکتر شاه1کشی صنعتینقشه
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4-Explode

Explode:نام دستور

:زبانه

Modify -> Explode     

:آیکن :حرف خلاصه

X

ویرایشیدستوراتتازنیممیراستکلیکسپسکردهانتخابراموضوعابتداکاراینبرای.شودمیاستفادهراسقسمتازموضوعاتنمودنجدابرای
.شوداعمالهاآنروی
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5-Xline

Xline:نام دستور

:زبانه

Draw  ->  Xline

:آیکن :حرف خلاصه

Xl

.پارامتر‌زیر‌است5شود‌که‌دارای‌برای‌ترسیم‌خط‌دو‌سر‌نا‌محدود‌استفاده‌می

سوندی ، دکتر شاه1کشی صنعتینقشه
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6-Ray 

Ray:نام دستور

:زبانه

Draw       Ray

:آیکن :حرف خلاصه

---

.گیردها‌مورد‌استفاده‌قرار‌میگویند‌که‌به‌عنوان‌خط‌راهنما‌در‌نقشهبه‌آن‌خط‌یک‌سر‌نامحدود‌می

سوندی ، دکتر شاه1کشی صنعتینقشه
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7-Point

Point :نام دستور

:زبانه

  Draw  ->  Point

:آیکن  :حرف خلاصه

PO

سوندی ، دکتر شاه1کشی صنعتینقشه
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8-Circle

Circle:نام دستور

:زبانه

Draw -> Circle

:آیکن :حرف خلاصه

C

سوندی ، دکتر شاه1کشی صنعتینقشه
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Polygon:نام دستور

:زبانه

Draw ->  Polygon

:آیکن :حرف خلاصه

Pol

9-Polygon

)Number of sides )تعداد‌اضلاع‌   

(Center of Polygon )مرکز‌چند‌ضلعی‌

(Circumscribed about circle)محیطی‌

(Inscribed in circle)محاطی‌

(EDGE)ضلع‌

FIREST POINT 

نقطه‌اول

SECEND POINT

نقطه‌دوم‌

سوندی ، دکتر شاه1کشی صنعتینقشه
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سوندی ، دکتر شاه1کشی صنعتینقشه
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10-Copy

Copy:نام دستور

:زبانه

Modify -> Copy

:آیکن :حرف خلاصه

Co-Cp

سوندی ، دکتر شاه1کشی صنعتینقشه
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11-Move 

Move:نام دستور

:زبانه

Modify -> Move

:آیکن :حرف خلاصه

M

سوندی ، دکتر شاه1کشی صنعتینقشه
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12-Mirror

Mirror:نام دستور

:زبانه

Modify ->  Mirror

:آیکن :حرف خلاصه

MI

سوندی ، دکتر شاه1کشی صنعتینقشه
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13-Offset

Offset:نام دستور

:زبانه

Modify ->  Offset

:آیکن :حرف خلاصه

O

سوندی ، دکتر شاه1کشی صنعتینقشه
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14-Trim

Trim:نام دستور

:زبانه

Modify         Trim

:آیکن :حرف خلاصه

Tr

سوندی ، دکتر شاه1کشی صنعتینقشه
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15-Extend

Extend:نام دستور

:زبانه

Modify  ->  Extend

:آیکن :حرف خلاصه

EX

سوندی ، دکتر شاه1کشی صنعتینقشه
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16-Break at Point

Break at Point:نام دستور

:زبانه

Modify -> Break at Point

:آیکن :حرف خلاصه

---

سوندی ، دکتر شاه1کشی صنعتینقشه



165

17-Break

Break:  نام دستور

:زبانه

Modify  -> Break

:آیکن :حرف خلاصه

BR

سوندی ، دکتر شاه1کشی صنعتینقشه
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18-Join 

Join:  نام دستور

:زبانه

Modify  ->  Join   

:آیکن :حرف خلاصه

J

سوندی ، دکتر شاه1کشی صنعتینقشه
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19-Object Snap

می
سی

 تر
ک

کم
ی 

رها
بزا

ا

Object 
Snap

O
b

je
ct

 S
n

ap آیکن

O
b

je
ct

 S
n

ap حرف خلاصه

OS   

سوندی ، دکتر شاه1کشی صنعتینقشه
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سوندی ، دکتر شاه1کشی صنعتینقشه
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سوندی ، دکتر شاه1کشی صنعتینقشه
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:ها Object snapروش های دسترسی به 

سوندی ، دکتر شاه1کشی صنعتینقشه
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Object Snapهای دسترسی به جدول روش

سوندی ، دکتر شاه1کشی صنعتینقشه



172

سوندی ، دکتر شاه1کشی صنعتینقشه
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177
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Polar Array Rectangular Array

Path Array
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20-Polar Array

Polar Array :نام دستور

:زبانه

  Modify  ->  Array  ->   

Polar Array

:آیکن  :دستور
ARRAYPOLAR
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20-Polar Array
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21- Rectangular Array 

 Rectangular Array :نام دستور

:زبانه

  Modify -> Array ->    
Rectangular Array       

:آیکن  :حرف خلاصه
ARRAYRECT
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22-Path Array

Path Array :نام دستور

:زبانه

  Modify  ->  PATH ARRAY

:آیکن  :حرف خلاصه
ARRAYPATH
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22-Path Array



185
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Technical drawing pen size: 

https://www.designingbuildings.co.uk/wiki/Paper_Sizes

Note: m ISO = metric ISO
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Layers

لایه ها()  آیکن 

.اندهای شفافی بوده که بر روی هم قرار گرفتهی کاغذلایه ها در نرم افزار اتوکد به منزله

5-38Layers 



189

هاطریقه ی ایجاد و ویرایش لایه❖
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1-New layer :شودی جدید استفاده میبه منظور ایجاد یک لایه.

2-Delete layer :شودها استفاده میبرای پاک کردن لایه.
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3-Name  : برای معرفی نام لایه استفاده می شود که می توانیم با زدن کلیدF2یا دابل کلیک بر روی آن، نام لایه را تغییر دهیم.

4-Turns layer on or off :شودمیاستفادههالایهکردنروشنیاخاموشمنظوربهآیکونایناز.

5-Freeze or thaws :ا به به معنای فریز کردن یا ذوب کردن می باشد و اجازه می دهد تا لایه ها ر
.طور موقت مخفی کرده یا نمایان کنیم

؟؟؟چیستدرFreeze or thawsبا Turn Layer on or offتفاوت
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ISO 128-50
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5-23Hatch 

Hatch:نام دستور

:زبانه

  Draw  ->  Hatch

:آیکن :حرف خلاصه

H

(زیرهمانند شکل.)به منظور ایجاد هاشور بر روی موضوعات استفاده می شود: Hatchسربرگ
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:شوندمیتقسیمدسته2بهاتوکددرهاهاشور

درآمادهصورتبههاشورهااین:Predefinedیاایکتابخانههاشورهای-1
.دارندوجودمتنوعالگوهایبااتوکد

:باشدمیزیرصورتبههاالگواینبهدسترسیینحوه

.کلیک نماییدOKاز پنجره ی ظاهر شده موضوع مورد نظر را انتخاب کرده و بر روی 

.باشدمیصافخطصورتبهتنهاونداشتهالگوییهیچ:سادههاشورهای-2
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.برای تعیین زاویه و مقیاس می توانید به یکی از دو صورت زیر عمل نمایید
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(pick point):بازمرزهایدرونوشدهاستفادهبستهمرزهایبرایفقطerrorدهدمی.

(Select object):شودمیاستفادهبازمرزهایبرایهموبستهمرزهایبرایهم.

عات برای انتخاب موضوعات تودرتو استفاده کنیم، موضوSelect object در صورتی که از
.یکی در میان هاشور می خورند
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تودرتومرزهایدرزدنهاشوریطریقه
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.شودبه منظور ایجاد هاشورهای رنگ بر روی موضوعات استفاده می: gradientسربرگ ✓
:روش اجرا
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:هاشورهاویرایشیطریقه

.کنیممیانتخابراHatch Editیگزینهوکردهراستکلیکآنرویهاشورها،انتخابازپس-1

.کنیممیکلیکدابلهاشورهارویبر-2
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Dtextیا Text:نام دستور

:زبانه

  Draw  ->  Text -> 

      Single Text Line

:آیکن :حرف خلاصه

T یاDT

5-24DTEXT 

.شودمیاستفادهصفحهدرونبهمتنکردنواردبرایدستورایناز

تغییربرایتوانمینیز Alt + Shiftترکیبیکلیداز.دادخاتمهمتنبهآنفشردنباردوباورفتهجدیدسطربهEnterکلیدباریکفشردنباتوانمیتایپهنگامدر
.کرداستفادهنوشتاریزبان
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.گیرندهایی به صورت زیر است که برای تنظیم متن درون صفحه مورد استفاده قرار میاین پارامتر دارای گزینهJustify:پارامتر 

.دهدبوده که با گرفتن دو نقطه، متن را بین آنها قرار میFitاز مهمترین گزینه های آن پارامتر

.کنیداجراراDTEXTدستور-1

.را انتخاب کنید Justifyپارامتر -2

.را انتخاب کنیدFitی گزینه-3

.نقطه ی اول را مشخص کنید-4

.نقطه ی دوم را مشخص کنید-5
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Right))راستCenter))وسطLeft))چپ***

TRTCTLTop))بالا

MRMCMLMiddle))وسط

BRBCBLBottom))پایین

.نماییدواردراصفرمقداروکردهاجراراMirrtextدستورشد،قرینهنیزهانوشتهMirrorدستورازاستفادههنگامدرکهصورتیدر
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5-25STYLE 

Style:نام دستور

:زبانه

  Format  ->  Text 
Style

:آیکن :حرف خلاصه

ST
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ازکهصورتیدر verticalیگزینه
استفادهshxپسوندباهاییفونت
.استفعالکنیممی
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Mtext:نام دستور

:زبانه

  Draw -> Text ->

         Multiline Text

:آیکن :حرف خلاصه

MT

5-26Mtext

.گیرد این دستور برای نوشتن متن با امکانات بیشتر مورد استفاده قرار می

.بزنیدEnterوکردهتایپفرمانخطدرراMTدستور-1

.کنیدکلیکصفحهدردلخواهمحلدر-2

.کنیدانتخابرامستطیلراسازدومینقطه-3
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.کندایجادمتندررانیازموردتغییراتتادهدمیراامکاناینکاربربهکهشدهظاهرزیرصورتبهایپنجرهدومینقطهانتخابازپس
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انتخابراتصویریکاراکترهایتوانیممیwحروفبخشازکهشدهظاهرجدولیکنیمانتخابرا Otherیگزینه Symbolرویبرکلیکازپسکهصورتیدر
.کنیمواردصفحهدرونبههاآن copyیدکمهزدنباوکرده
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23-Arc

 Arc :نام دستور

:زبانه

  Draw  ->  Arc

:آیکن  :حرف خلاصه

A
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24-Scale

Scale:  نام دستور

:زبانه

Modify ->  Scale

:آیکن :حرف خلاصه

SC
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Scale:  نام دستور

:زبانه

Modify ->  Scale

:آیکن :حرف خلاصه

SC

24-Scale
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25-Rotate

Rotate:  نام دستور

:زبانه

Modify         Rotate

:آیکن :حرف خلاصه

RO
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25-Rotate

Rotate:  نام دستور

:زبانه

Modify  -> Rotate

:آیکن :حرف خلاصه

RO
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26-Rotate

Rotate:  نام دستور

:زبانه

Modify -> Rotate

:آیکن :حرف خلاصه

RO
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D
es

ig
n

 C
en

te
r آیکن

D
es

ig
n

 C
en

te
r

بیکلید ترکی

Ctrl+2 D
es

ig
n

 C
en

te
r

حرف خلاصه

DC   

Design Centerایناجرایازپس.باشدمیاتوکددرونآمادهالگوهایازبسیاریمرکز
.نمودواردصفحهدرونبهراموضوعاتزیرصورتبهتوانمیدستور

27-Design Center 



219

.کنیدواردصفحهدرونبه DRAG & DRAWیوسیلهبهرانظرموردترسیمات، Blockقسمتازنهایتدر
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28-Tool Palettes
To

o
l P

al
et

te
s آیکن

To
o

l P
al

et
te

s

بیکلید ترکی

Ctrl+3 To
o

l P
al

et
te

s

حرف خلاصه

TP   

Tool Palettesخودنظرموردهایمدلاجرا،ازبعدبتوانندکاربرانتاشدهباعث
مدلباهامدلاینتفاوتاستذکربهلازم.کنندفراخوانیصفحهدرونبهرا

یآبمثلثعلامتیکنمادهااینازیکهرانتخابباکهاستایندرDCهای
ازمختلفیهایمدلبتوانندکاربراندهدمیاجازهکهشدهظاهرهاآنکناردر
.گویندمیپویاهامدلاینبهدلیلهمینبهکنند،مشاهدراالگوآن
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29-Chamfer

 Chamfer :نام دستور

:زبانه

  Modify -> Chamfer

:آیکن  :حرف خلاصه

Cha
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29-Chamfer

 Chamfer :نام دستور

:زبانه

  Modify -> Chamfer

:آیکن  :حرف خلاصه

Cha
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30-Fillet

 Fillet :نام دستور

:زبانه

  Modify ->  Fillet

:آیکن  :حرف خلاصه

F
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31-Stretch

 Stretch :نام دستور

:زبانه

  Modify ->  Stretch

:آیکن  :حرف خلاصه

S
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32-BLEND CURVES

 BLEND CURVES :نام دستور

:زبانه

  Modify  ->  Blend 
Curves

:آیکن  :حرف خلاصه

--
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رسم اشکال ایزومتریک
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تصاویر مجسم

https://rockbench.ir/drawing-10/

.شوندزاویه محورها به سه دسته تقسیم میتصاویر مجسم بر اساس
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تغییر جهت خطوط شبکه برای ترسیم تصاویر ایزومتریک 
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ترسیم دایره ایزومتریک 

Ellipse:  نام دستور

:زبانه

Draw ->  ellipse

:آیکن :حرف خلاصه

El
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ترسیم در محیط سه بعدی اتوکد
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انجام تنظیمات محیط سه بعدی
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ابزار ترسیم اشکال مختلف سه بعدی
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ابزار افزایش و کاهش حجم
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ابزار افزایش و کاهش حجم
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ابزار برش احجام
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ابزارهای ویرایش

، Moveسایر ابزارهای ویرایش مورد بحث در ترسیم دو بعدی نظیر  
Copy ،Offsetو غیره در محیط دوبعدی نیز کاربرد دارند.

Copy Move Rotate
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ابزاریکپارچه سازی

.برای ادغام چند شکل و تولید یک جسم یکپارچه کاربرد دارد
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Rotate:  نام دستور

:زبانه

Modify  -> Rotate

:آیکن :حرف خلاصه

RO
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مجهول یابی
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252
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آنالیز سطوح



255
صفحه نوع اول

صفحه نوع دوم

صفحه نوع سوم
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:هقوانین حاکم بین دو صفح

:قوانین حاکم بین صفحه و خط

.دارای محدوده یکسان باشند-1

.ها در هر دو تصویر یکسان باشدتعداد گوشه-2

.دهر دو گوشه متناظر بر روی یک رابط باشن-3

.هر دو شکل از نظر هندسی متشابه باشند-4

.دارای محدوده یکسان باشند-1

ط ها در صفحه با تعداد انفصال در ختعداد رابط-2

.برابر باشد

ر روی هر گوشه و نقطه انفصال متناظر ب-3

.یک رابط باشند
برگرفته از طرح درس آقای مهندس مهدی ایمان



257

:هقوانین حاکم بین دو صفح

:قوانین حاکم بین صفحه و خط

.دارای محدوده یکسان باشند-1

.ها در هر دو تصویر یکسان باشدتعداد گوشه-2

.دهر دو گوشه متناظر بر روی یک رابط باشن-3

.هر دو شکل از نظر هندسی متشابه باشند-4

.دارای محدوده یکسان باشند-1

ط ها در صفحه با تعداد انفصال در ختعداد رابط-2

.برابر باشد

ر روی هر گوشه و نقطه انفصال متناظر ب-3

.یک رابط باشند
برگرفته از طرح درس آقای مهندس مهدی ایمان
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برگرفته از طرح درس آقای مهندس مهدی ایمان
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برگرفته از طرح درس آقای مهندس مهدی ایمان
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برگرفته از طرح درس آقای مهندس مهدی ایمان
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:هقوانین حاکم بین دو صفح

.دارای محدوده یکسان باشند-1

.ها در هر دو تصویر یکسان باشدتعداد گوشه-2

.دهر دو گوشه متناظر بر روی یک رابط باشن-3

.هر دو شکل از نظر هندسی متشابه باشند-4
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:هقوانین حاکم بین دو صفح

.دارای محدوده یکسان باشند-1

.ها در هر دو تصویر یکسان باشدتعداد گوشه-2

.دهر دو گوشه متناظر بر روی یک رابط باشن-3

.اشندهر دو شکل از نظر هندسی متشابه ب-4

.اشنداضلاع موازی با هم در نمای دیگر نیز موازی ب4-1

.ر باشندنسبت اضلاع موازی در دو نما براب4-2
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:هقوانین حاکم بین دو صفح

.دارای محدوده یکسان باشند-1

.ها در هر دو تصویر یکسان باشدتعداد گوشه-2

.دهر دو گوشه متناظر بر روی یک رابط باشن-3

.اشندهر دو شکل از نظر هندسی متشابه ب-4

.اشنداضلاع موازی با هم در نمای دیگر نیز موازی ب4-1

.ر باشندنسبت اضلاع موازی در دو نما براب4-2
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انواع برش

برش ساده یا برش کامل-1

برش مرکب یا برش شکسته قائم-2

برش متوالی یا پشت سر هم-3

برش شعاعی یا برش شکسته مایل-4

برش خاص-5

برش گردشی یا چرخشی یا دورانی-6

برش موضعی-8

برش جابجایی-7

نیم برش-9
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انواع برش

برش ساده یا برش کامل-1

برش مرکب یا برش شکسته قائم-2

برش متوالی یا پشت سر هم-3

برش شعاعی یا برش شکسته مایل-4

برش خاص-5

برش گردشی یا چرخشی یا دورانی-6

برش موضعی-8

برش جابجایی-7

نیم برش-9
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انواع برش

برش ساده یا برش کامل-1

برش مرکب یا برش شکسته قائم-2

برش متوالی یا پشت سر هم-3

برش شعاعی یا برش شکسته مایل-4

برش خاص-5

برش گردشی یا چرخشی یا دورانی-6

برش موضعی-8

سوندی ، مهندس شاه1کشی صنعتینقشه

برش جابجایی-7

نیم برش-9
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انواع برش

برش ساده یا برش کامل-1

برش مرکب یا برش شکسته قائم-2
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گذاریاندازه
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گذاریاصول اندازه

.ها خودداری شوداز تکرار اندازه-1
.ای نباید کم باشدهیچ اندازه-2
.ها در اطراف تصویر پخش شونداندازه-3
.توان عمل نموداگر فضای کافی وجود ندارد به صورت زیر می-4
.تواند به خط اصلی تکیه کندفلش می-5
.تواند به خط ندید تکیه کندفلش می-6
.کنیماستفاده میRبرای نمایش شعاع همیشه از حرف -7
.کنیماستفاده میφبرای نمایش قطر همواره از -9
توان به جای خط اندازه استفاده از خطوط اصلی و محور تقارن نمی-8

.توان از آن به عنوان خط رابط اندازه یا کمکی بهره گرفتولی می. کرد
.کنیماستفاده می□برای نمایش مقطع مربع، از علامت -9

های افقی، در وسط خط اندازه و بالای آن گذاری، اندازهدر اندازه-10
.شودنوشته می

های عمودی در سمت چپ خط اندازه نوشته گذاری، اندازهدر اندازه-11
.ای که از سمت راست خوانده شودشود، به گونهمی
های اندازه پشت فاصله خط اندازه تا خط اصلی و همچنین فاصله خط-12

.میلی متر است7/5سر هم 
.شوندتر اول نوشته میهای کوچکگذاری همیشه اندازهدر اندازه-13
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گذاریانواع اندازه

ایگذاری پلهاندازه
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گذاریانواع اندازه

ایگذاری زنجیرهاندازه
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گذاری زوایااندازهگذاری روی شیباندازه
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ها، وتر و زوایاگذاری قوساندازه
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هاگذاری پخاندازه
گذاری قطعات کرویاندازه
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های مشابهگذاری سوراخاندازهگذاری قطعات نازکاندازه
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گذاری برای قطعات با خط شکستگیاندازه
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